Jim Heid reveals the secrets of iPhoto 5, iMovie HD, iDVD 5, and GarageBand 2 in this sneak preview of the new edition of the book/DVD, The Macintosh iLife ’05.

**iPhoto 5:** Better books, advanced editing, and support for raw images and movie clips

**iMovie HD:** High-definition video for the rest of us, and editing on autopilot

**iDVD 5:** New themes, dynamic drop zones, and enhanced authoring

**GarageBand 2:** Multitrack recording, music notation, and more sonic options

**Jam Pack 4:** There’s a symphony on your desktop

A new year, a new iLife. Since its debut two years ago, Apple’s iLife suite has set the standard for personal media management and production. From music to photos to movies, digital media comes together—and comes alive—in iLife.

This month, Apple delivers the most ambitious iLife update yet. iLife ’05 includes new versions of iPhoto, iMovie, iDVD, and GarageBand. Each program is refined and enhanced, and all four programs—along with iTunes—work together better than ever. Call it a suite maturation.

iLife ’05 will be included with all new Macs, and will also be available separately for $79.

This booklet is a sneak preview of the next edition of my book and instructional DVD, now called The Macintosh iLife ’05. I’ve worked extensively with iLife ’05, and the book excerpts here highlight some of the suite’s best new features: iPhoto’s spectacular new books, enhanced editing, and broader media support; iMovie HD’s high-definition and widescreen enhancements; iDVD’s beautiful new design themes and enhanced authoring features; and GarageBand’s multitrack recording capability, improved loop features, and new sonic options.

If this booklet whets your appetite, please see the back cover for details on how to order The Macintosh iLife ’05 at a hefty discount. The back cover also has details on iLifeTV, a series of online movies spotlighting new iLife features, produced by Avondale Media.

Now turn the page to begin touring iLife ’05—and the latest edition of the top-selling book on iLife.
iPhoto at a Glance

Millions of photographs lead lives of loneliness, trapped in unorganized boxes where they’re never seen. Their digital brethren often share the same fate, exiled to cluttered folders on a hard drive and rarely opened.

With iPhoto, you can free your photos—and organize, print, and share them, too. iPhoto simplifies the entire process. You begin by importing images from a digital camera, your hard drive, a CD from a photofinisher, or other source. Then you can create albums, organizing the images in whatever order you want. You can even have iPhoto create the albums for you.

Along the way, you might also use iPhoto’s editing features to retouch flaws, improve brightness and contrast, remove red-eye, and crop out unwanted portions of images. And you might use iPhoto’s keyword features and search box to help you file and locate images.

When you’ve finished organizing and editing photos, share them. Email them to friends and family. Order prints or make your own. Design gorgeous photo books, arranging photos on each page and adding captions. Create slide shows, complete with music from iTunes, and then watch them on the Mac’s screen, burn them to DVDs, or transfer them to an iPod Photo.

Welcome to the Photo Liberation Society.

Beyond the Shoebox

Use the panes in the lower-left corner of the iPhoto window to view and edit information, find photos from specific dates, and assign descriptive keywords. To display a pane, click its button (circled below).

**Information pane.** Edit information for photos, albums, and books (page 100).

**Calendar pane.** Quickly view photos from specific dates, weeks, or months (page 108).

**Keywords pane.** Assign keywords to photos to make them easier to find and organize (page 118).

**Using iPhoto at a Glance.**

**iPhoto and Digital Photography**

**Picture more power.** iPhoto has always provided on-screen slide shows and book-publishing features. iPhoto 5 takes slide shows and books to the next level. As the excerpt above shows, slide shows and books are now separate entities that exist apart from the albums on which they’re based. One benefit: There’s no risk of altering a slide show or book by making a change in an album.

This new approach also gives you more flexibility. For example, you can apply effects, such as black and white or sepia tone, to the photos in a slide show—without affecting the original photos.

iPhoto 5 slide shows make this digital projector even brighter. Ken Burns has set up a branch office: you can add panning and zooming to the photos in a slide show.

Drag the size slider to specify zooming, then click the Preview button to check your work.

Want immediate results? Click the Automatic Ken Burns Effect box in the Slideshow Burns Effect box in the Slideshow dialog box, and iPhoto applies panning and zooming for you.
To quickly see photos from a recent year, click the triangle (page 92).

To see the last set of photos you imported, click Last Roll (page 98).

Use folders to organize albums, books, and slide shows (page 94).

Use smart albums to have iPhoto create albums for you (page 95).

Assemble photos into albums, and then share the albums (pages 102–103).

Create and print photo books (pages 122–123).

Create and display slide shows (pages 116–117).

The Trash holds photos you delete.

The Library contains everything you import into iPhoto. Each set of items you import is called a roll, as in roll of film.

To show or hide a roll’s images, click the triangle. Note: If your library isn’t being displayed by roll, choose Film Rolls from the View menu.

Get in the habit of giving each roll a descriptive name (page 112).

To resize the Source area, drag this bar left or right.

iPhoto can also store movie clips, such as those taken by a digital camera. Movie clips are labeled with a movie badge (page 113).

Create a new album, book, or slide show.

To zoom in and out on photos, drag the size slider.

Edit and share photos.

Play a slide show (page 95).

Use the Search box to quickly locate photos (page 119).

iPhoto veterans will notice other changes. You can create folders to organize albums, slide shows, and books. And the Import button is gone. iPhoto 5 displays its new Import panel automatically when you connect a camera or media reader. The new panel also provides boxes that let you name the set of images that you’re about to bring in.

That’s just one way iPhoto 5 makes it easier to keep track of your photos. There’s also a new search box, which lets you locate photos by typing text that appears in their file names, titles, comments, keywords, or roll names. Like its counterpart in iTunes, iPhoto 5’s search engine instantly displays photos that meet your search criteria as you type.

And like iPhoto 4, iPhoto 5 works together with iTunes 4.7.1 to enable you to synchronize part or all of your photo library with Apple’s colorful iPod photo. You’ll find full details on iPod photo—and the rest of iPod product line—in The Macintosh iLife ’05. Better organization, cinematic slide shows, and photos to go—now that’s a picture any digital photographer can appreciate.

Reviewers rave:
The layout of the book is highly accessible. Rather than imposing pages of unrelenting text, the book is filled with screenshots, diagrams and all sorts of helpful, easy-to-follow instructions. Even with all the pictures, this book is no lightweight. There is a wealth of information on all the iLife products.
— R.C., on Amazon.com
Advanced Editing with the Adjust Window

Some photos need more help than others. That shot of a beach sunset would be more dramatic if the ocean didn’t appear to be slanted uphill. That shot of a beautiful white gardenia would be prettier if the flower didn’t have a jaundiced yellow color cast. And that scene of Paris on a rainy day would look more romantic if it didn’t appear so flat and washed out.

To fix problems like these, use the Adjust window—its controls let you straighten a crooked photo, adjust the sharpness of a photo, fine-tune exposure, tweak color balance, and more.

The basics of the Adjust window are a cinch: after opening a photo for editing (see page 106), summon the Adjust window by clicking the Adjust button in the Edit toolbar. Then, drag the appropriate sliders left or right until you get the desired results.

That last part—getting the desired results—isn’t always a cinch. Adjusting exposure, color balance, and sharpness can be tricky, and knowing a few digital imaging concepts can help you reach your goals. You’ll find a detailed look at these concepts in the following pages and on the DVD. Here’s the big picture.

A Sampling of Adjustments

Straighten Crooked Shots

Horizon a little crooked? Use the Straighten slider to level things out (opposite page).

Fix Color Problems

Use the Saturation, Temperature, and Tint sliders to remove unwanted color casts, increase or decrease color vividness, and more (pages 122–123).

Exposure

Use the Exposure and Levels sliders to brighten or darken photos and improve contrast (pages 124–125).

More polish to your pixels.  

iPhoto 5 sports a significantly remodeled darkroom. As the excerpt above shows, when you open a photo for editing, the iPhoto edit view displays small thumbnail versions of the photos that surround it in the library (or album or book). When you’re ready to edit a different photo, just double-click it. There’s no need to leave edit mode.

It gets better. The new Adjust window provides a powerful set of image-editing features for improving color balance, sharpening, and more. Its straighten feature is a delight: as you drag the slider, iPhoto straightens and crops a photo at the same time. You’ll wonder how you lived without it.

Now let’s talk raw. More and more cameras can shoot in raw mode, saving the exact information captured by the camera’s light sensor. Switch your camera into raw mode, and you enter a new world of image-enhancement possibilities. Instead of having to live with the alterations made by the camera’s internal software, you get the original, unprocessed, uncompressed image data—the raw data—captured by the camera’s sensor. Transfer this
raw image to the Mac, and you can use iPhoto to obtain a degree of image quality that you can’t get when shooting in JPEG.

Best of all, working with raw files is almost identical to working with JPEG images. Some subtleties surround the use of raw images in iPhoto 5 and iLife ’05, but generally, iPhoto manages the technical complexities of the raw format for you. (And every one of those subtleties is covered in The Macintosh iLife ’05 book and its companion instructional DVD.)

How do you get raw images into iMovie HD or iDVD? Easy: when you import a raw image, iPhoto also creates a JPEG version that’s ready to use in your DVDs and movies.

Speaking of movies, most digital cameras can shoot them, and they’re a great way to capture more than just a single moment. Previous iPhoto versions ignored movie clips, but iPhoto 5 imports them along with your photos. Double-click a clip, and it plays in QuickTime Player. iPhoto 5 supports any QuickTime-compatible video format.
Creating Photo Books

Something special happens to photos when they’re pasted into the pages of a book. Arranged in a specific order and accompanied by captions, photos form a narrative: they tell a story.

Put away your paste. With iPhoto’s book mode, you can create beautiful, full-color books in several sizes and styles. Arrange your photos in the order you want, adding captions and descriptive text if you like. Choose from a gallery of design themes to spice up your pages with layouts that complement your subject.

When you’re done, iPhoto connects to the Internet and transfers your book to Apple’s printing service, where the book is printed on a four-color digital printing press (a Hewlett-Packard Indigo, if you’re curious), and then bound and shipped to you.

iPhoto books are great for commemorating a vacation, wedding, or other special event. They’re also open for business: architects, artists, photographers, and designers use iPhoto to create spectacular portfolios, proposals, and brochures.

If you wrestled with the book mode in earlier iPhoto versions, prepare to celebrate. Creating a book in iPhoto 5 is much easier. The books themselves are also better looking, thanks to a set of glittering new design themes.

So don’t just print those extra-special shots. Publish them.

Creating a Book: The Big Picture

The most efficient way to create a book is to first add photos to an album, and then tell iPhoto to create a book based on that album. Here’s an overview of the process. Tip: If you’ve never created a book in iPhoto 5, watch the DVD for a guided tour.

Step 1.

Create a new album containing the photos you want to publish (page 102). Arrange the photos in approximately the same order that you want them to appear in the book. (You can always change their order later.)

Step 2.

Select the album in the Source list, then choose New Book from the File menu (or click the Book button or the Add button ).

Step 3.

Choose a book type and a theme, then click Choose Theme. For a summary of the types of books you can order, see the sidebar at right.

Meet your new publisher.

Creating books in earlier iPhoto versions was, shall we say, challenging at times. For example, if you removed a photo from a page, that change could ripple throughout the book, altering the layout of other pages.

In iPhoto 5, books are much easier to create. If you remove a photo from a page, you don’t affect the layout of the entire book. iPhoto simply stashes that photo in a holding area called the photo browser.

Like its counterpart in iPhoto’s edit view, the photo browser appears along the top of the iPhoto window. The photo browser is a virtual light table, a place to hold photos before you add them to a page. Go ahead and experiment: drag photos between pages and the photo browser until each page is just so.

Like earlier iPhoto versions, iPhoto 5 will lay out a book for you automatically. But only if you want it to—iPhoto 5 also lets you position each photo individually, by dragging it from the photo browser onto the page.

The books themselves are a visual feast. New design themes and page backgrounds let you create books that complement...
your subjects: a new baby, a vacation, a kid’s birthday party. And the Contemporary and Folio themes have a stylish look that wouldn’t be out of place on an architect’s coffee table. Each theme provides several page designs, many providing beautiful textured backgrounds. Some designs even apply special effects to your photos.

iPhoto 5 also lets you create books with photos printed on both sides of each page. Combine this capability with the new themes and page designs, and you can create books containing gorgeous, full-color, two-page spreads—just like you’ll find in The Macintosh iLife ‘05.

Because iPhoto 5 treats books as entities separate from the albums on which they’re based, you can create several books from one album: make a large hardcover book for yourself, a medium-sized softcover book for your parents, and a few small picture books for friends.

iPhoto 5: you’ll be making books on it.

Reviewers rave:

Jim has done a great job distilling these feature-rich applications down to their essence... The included DVD is well done and augments the book with a step-by-step explanation that you can follow visually.

—J.H., on Amazon.com

Step 4.

Lay out the book.

You can have iPhoto place the photos for you (the autoflow mode), or you can manually place each photo yourself (see the following pages).

Switch between viewing page thumbnails (shown here) or photos that you haven’t yet placed in the book (page 110). To reposition a photo within its book frame, double-click the photo and drag the size control (page 111).

Step 5.

Click Buy Book (Buy Book) and pay up using your Apple ID (page 118).

Four Types of Books

**Large Hardcover.** The classiest book option, and the priciest. The front-cover photo is attached to the linen hardcover.

**Large Softcover.** A big book on a budget. The white cover contains a cutout revealing the book’s first page.

**Medium Softcover.** Smaller page sizes and a much smaller price. The color-coordinated cover has its own photo.

**Small Softcover.** Photos to go: up to 100 pages of pictures in your pocket. Small softcover books are sold in packs of three.

<table>
<thead>
<tr>
<th>Base book</th>
<th>Each extra page: $ .99–1.49</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Hardcover</td>
<td>$29.99</td>
</tr>
<tr>
<td>Large Softcover</td>
<td>$19.99 each 20 pages</td>
</tr>
<tr>
<td>Medium Softcover</td>
<td>$9.99 each 20 pages</td>
</tr>
<tr>
<td>Small Softcover</td>
<td>$3.99 each 20 pages</td>
</tr>
</tbody>
</table>

(See page 112 for details.)
A Short Lesson in Video Formats

If you have a standard, miniDV camcorder and you’re anxious to start making movies, feel free to skip this little lesson and move on to page 170. But if you want to use video from a different kind of device—or you’re curious about one of iMovie HD’s most intriguing new capabilities—read on.

Just as music and photos can be stored in a variety of digital formats, video also comes in several flavors. And as with music and photos, each video format takes its own approach to organizing the bits and bytes that make up your media.

In previous iMovie versions, projects were based on one video format: DV. You could import other formats into iMovie, but iMovie would convert that footage into DV format. DV was iMovie’s native tongue, and using other formats meant a translation step that took time, used up disk space, and often compromised video quality.

Times change. New types of video devices have appeared, and iMovie has evolved to keep pace: iMovie HD provides native support for several video formats. iMovie HD is multilingual, and as a result, you have the flexibility to edit video from a wider variety of video devices, ranging from Apple’s inexpensive iSight to many digital cameras models to the new breed of high-definition HDV cameras from companies such as Sony and JVC.

iMovie HD’s basic operation is identical regardless of which video format you use. There are some subtleties to some formats, and I’ll share them as we go. But first, let’s look at the video languages iMovie HD understands.

How Square Are Your Movies?

Many of the differences among video formats aren’t visible at first glance, but one of the differences definitely is: the aspect ratio of the video frame.

We encountered the concept of aspect ratio when looking at iPhoto cropping techniques (page 129). The phrase simply describes how square or rectangular an image frame is.

Previous iMovie versions were limited to one aspect ratio: the standard 4:3 ratio used by most TV sets, DV camcorders, and digital cameras.

Going wide. iMovie HD adds the ability to work with and create widescreen video in the 16:9 aspect ratio—the format common in high-definition TV sets.

The widescreen format provides a more cinematic experience.

Pronunciation guide. Making video small talk at the local coffee shop? The expressions 4:3 and 16:9 are usually pronounced “four by three” and “sixteen by nine.” Technically, “four to three” and “sixteen to nine” are more accurate, since these expressions are ratios. After all, when was the last time you heard a bookie describe “2 by 1” odds on a horse?

A wider view. As the book excerpt above shows, iMovie HD goes beyond the standard DV video format to provide support for high-definition video, widescreen DV, and more.

iMovie HD is even smart enough to detect which format you’re using. For example, if you choose DV for a brand-new project but then begin importing some widescreen DV, iMovie automatically switches the project’s video format to DV widescreen.

iMovie HD sports numerous enhancements that, taken together, add up to a much more refined program. You can copy and paste clips between projects—something previous iMovie versions didn’t permit. When working in the timeline viewer, you can drag clips to rearrange their order. You can also drag clips from the timeline viewer back to the clips pane. And you can drag and drop clips from iMovie to iDVD.

As for eye candy, it’s here and it’s sweet. The new Glass Distortion effect simulates the look of old, rippled glass. The new Edges filter creates an edgy, neon-like look. The Crystallize effect makes a clip look like it’s being viewed through a textured shower door, while the new Edge Work effect creates a beautiful, pen-and-ink look.
Choosing a Video Format

Normally, iMovie HD projects are based on the DV format. If you’re using a standard miniDV camcorder with its factory settings, you don’t have to bother with choosing a format since iMovie HD is preset to speak its mother tongue.

If you’re using a different kind of device or you’ve set your DV camera to 16:9 mode, you need to tell iMovie HD which format to use. You do that when creating a new project.

To access the Format pop-up menu, click the triangle.

DV. By far the most common format used by digital camcorders, and the format iMovie HD uses for any new project unless you specify otherwise. Now that high-definition TV is upon us, the DV format is often described as a standard definition format.

DV Widescreen. Most DV camcorders can shoot in widescreen mode, often by simply cropping the top and bottom of the video frame. (To shoot in this mode, use your camcorder’s menus to activate 16:9 mode.) You don’t get the picture quality of high-definition TV, but you do get that cinematically wide image.

HDV 1080i and HDV 720p. High-definition TV (HD, for short) is gradually gaining momentum, and new breed of HDV camcorders is helping. The HD format brings high-definition videography to advanced amateurs and budget-minded professionals (and, as prices come down, to the rest of us). HDV always uses a 16:9 aspect ratio. For details on the HDV format, see pages 216–217.

MPEG-4. Many digital cameras shoot their movie clips in this format, as do a growing number of compact video cameras that connect via USB. For tips on importing and working with MPEG-4 clips, see page 200.

iSight. Apple’s inexpensive iSight camera is designed for video chatting using iChat AV, but it makes a great low-budget TV camera, too. For advice on shooting with an iSight, see page 208.

Mixing Video Formats in a Single Project

Sometimes, you may want to—or have to—mix video formats within a single project. Maybe you have a digital camera movie clip that you want to add to a project that’s in DV format. Or perhaps you have some 16:9 DV footage that you want to include in a 4:3 DV project. Or maybe you’re making a montage of MPEG-4 digital camera movies, but you’re using the DV format so you can output the final montage to a miniDV camcorder.

You can do all of these things and more. If you import a movie clip whose video format differs from your project’s format, iMovie HD converts the clip into whatever format your project uses. This conversion process is called transcoding, but you can also call it waiting—it can take a long time. And use a lot of disk space.

Say you import an MPEG-4 digital camera movie clip into a DV project. The movie clip might have a small frame size and use only 20MB of disk space, but in order to make it compatible with your DV-based project, iMovie will change its frame size and other characteristics to conform to the DV standard. The DV version of that movie might take up 120MB.

For these reasons, it’s best to stick with one video format within a single project. But when you don’t have a choice, iMovie HD is ready—provided you have the time and the disk space.

Billow transition, a series of ovals rapidly expands to reveal a new clip. In Disintegrate, one clip melts through the previous one. In Ripple, shown here, a reflective wave washes across the screen, replacing one clip with another. Your ears aren’t left out of the party, either. iMovie HD includes a greatly expanded collection of sound effects from the sonic superheroes at Skywalker Sound.

iMovie HD also provides several new transition styles. With the

Readers rave:
This combination of DVD and book suits my learning style well. What a refreshing style of presentation!

—E.B.
Magic iMovie: Editing on Autopilot

With many movie projects, you want control over every step of the editing process: timing cuts to match audio, trimming clips with precision, and fine-tuning your soundtrack until everything sparkles.

But sometimes you just want fast results. It’s Sunday afternoon, and your visiting relatives are (finally!) preparing to go home. You shot some video of the kids at the beach earlier that day, and you want to send everyone home with a freshly burned DVD. You can’t spend hours in the editing room—you want a movie now.

The Magic iMovie feature is for you. Choose a few options, then sit back and watch. iMovie HD imports video from your camera, adds an opening title, tosses a transition between each clip, adds a soundtrack from your iTunes library, and then ships the finished product off to iDVD. It’s editing on autopilot.

You can edit a Magic iMovie in any way you want, so you might also use the feature to create a rough cut. After iMovie HD gets you partway there, take the wheel and drive the rest of the way.

Is it magic? Hardly. But Magic iMovie is a fast way to spray some finish on your footage.

Note: If you just want to copy a tape to a DVD and don’t need transitions, titles, or a music soundtrack, check out the OneStep DVD feature in iDVD (page 236).

Making a Magic iMovie

To make a Magic iMovie, connect and turn on your DV or HDV camcorder (page 162). Then put iMovie HD to work.

Step 1. Choose Make a Magic iMovie from the File menu, and give your new movie project a name. If necessary, specify the desired video format (see page 164).

Step 2. Specify Magic iMovie settings.

Your movie’s opening title will contain this text, so keep it short.

To add a transition between every clip, check this box and choose a transition. Tip: Keep it tasteful and avoid the Random option.

To add a music soundtrack, check this box and click Choose Music (see Step 3 below).

If you plan to fine-tune your movie before burning a DVD, uncheck this box.

Step 3 (optional). Specify music soundtrack settings and click OK.

You can rearrange songs after you’ve added them by dragging them up and down.

To see songs from a specific playlist, choose the playlist’s name.

See “Soundtrack Options,” opposite page.

Step 4. Click Create.

You can delete individual clips, and even play a clip beforehand to make sure you really want to get rid of it. It’s another one of the small but significant refinements you’ll find in iMovie HD.

Here are more examples. In iMovie HD, a new Revert command lets you backtrack to the previously saved version of a project. It’s a great safety net: experiment with different editing approaches, and if you aren’t happy with what you’ve done, revert to your original.

Another way to experiment is to use the new Save As command to make a copy of your project. Just make room on your hard drive: the Save As command
Tips for Making Magic

Soundtrack Options
To set the volume of your music soundtrack, use the volume slider in the Choose Music dialog box. If your video contains dialog or other important audio, set the level fairly low to keep the music from overwhelming the other audio. Or, if your video contains nothing but wind noise and car horns, set the slider at Music Only to have iMovie HD mute the audio from your footage, leaving just the music.

As with anything Magic iMovie does, you can change the volume level later if you like. For details on working with audio levels, see page 180.

Shooting with Magic in Mind
If you know you’ll be using the Magic iMovie feature, there are some steps you can take to ensure that the magic happens correctly.

Take it from the top. The Magic iMovie feature always rewinds your tape to the very beginning. If the scenes you really want begin several minutes into a tape, you’ll have to delete the excess clips after iMovie HD does its job. A better approach is to shoot your magic-bound footage on a brand-new tape.

Knowing when to stop. The Magic iMovie feature stops importing video when it encounters ten seconds of blank tape (or when it reaches the very end of the tape). This means that you can’t capture just the first few minutes of a completely full tape. So again, if you know you’ll be using Magic iMovie, shoot your footage on a brand-new tape.

Get a Head Start
If you’re using Magic iMovie to give you a head start in editing and you plan to trim clips after the movie is assembled, consider unchecking the transition option. That way, iMovie HD won’t waste time creating transitions that you’ll end up deleting anyway.

Tweaking Chapter Markers
Normally, the Magic iMovie feature places a DVD chapter marker at beginning of each clip. If you don’t want to divvy up your movie into that many chapters, remove some or all of the markers by using the iDVD pane in iMovie HD (see page 210).

Adding Magic to a Movie
You don’t have to use Magic iMovie with a brand-new movie project. If you use the Make a Magic iMovie command when an existing project is open, iMovie HD simply adds the magic movie to the end of the existing project.

Similarly, you can add a Magic iMovie to a different project by copying and pasting its clips. This can be a fast way to put together a montage destined for a different project. Create a new project, then make a Magic iMovie. Then, choose Select All from the Edit menu, open a different project, position the playhead at the spot where you want the Magic iMovie to appear, and paste.

Note: Copying and pasting clips from one project to another can take several minutes and devour disk space. After the paste is complete, consider deleting the original Magic iMovie project file to free up disk space.

You’ll find full coverage of all new iMovie HD features in The Macintosh iLife ’05 book and on its accompanying DVD. In fact, that’s one reason why every edition of my book has included an instructional DVD—because by itself, the printed page doesn’t do justice to iLife.
Navigating and Authoring with Map View

iDVD’s map view lets you see the organization of your DVD project using a display that looks a lot like the organizational chart depicted on page 254.

In map view, you can see at a glance how your project is organized. More to the point, you can get around quickly. By double-clicking the icons in map view, you can jump to a specific menu or preview a slide show or movie. Need to drill down into a deeply nested submenu to do some design work? Display the map, then double-click the submenu’s icon.

Map view is about more than just seeing the big picture. You can use it to change menu themes, create menu transitions, and add content to your DVD. You can also use map view to loop a slide show or movie so that it plays over and over again. And you can use map view to have a movie or slide show start automatically when your DVD is played.

To switch to map view, click the Map button. To exit map view, click the Map button again, double-click an icon in the map, or click the Return button in the lower-right corner of the map.

Customizing Your View

When you’re on the road, sometimes you need the big picture and sometimes you need street-by-street details. Map view provides this flexibility and then some.

Switch between left-to-right (shown here) and top-to-bottom views.

To scroll quickly, drag the hand pointer within the map.

To zoom in and out on the map, drag the size slider. When zoomed out, you see only icons representing folders, slide shows, and movies.

When you zoom in, iDVD displays small thumbnail images as well as names of menus and other content.

If you don’t need to see a particular set of icons, click the right-pointing triangle to hide them and free up viewing space.

You can use the project icon to add AutoPlay content (opposite page).

Design options to burn. The big news in iDVD is a collection of new menu-design themes. iDVD’s themes have provided drop zones for some time now—they’re those areas of a menu that you can customize with your own photos or movies.

In iDVD 5, drop zones are dynamic—they can move across the screen, change shape, move behind one another, and even cast moving shadows.

If drop zones are moving around all the time, how do you access a specific one? With the new scrubber bar that appears beneath the menu area. Drag it left and right until the drop zone you want to edit is front and center.

Or just double-click on a drop zone. Doing so displays an editor window that works much like the slide show editor in iDVD.

Many of the new themes in iDVD 5 also have introductory animations—for example, when the menu first displays, the drop zones might glide into position, and then slowly travel across the screen. If you don’t want a menu to have this introductory portion,
Authoring in Map View

Map view is a handy place to customize menus, add content, and perform other authoring tasks.

Customizing Menus

To customize a menu in map view, click on the menu and then open the Customize drawer. To change the menu’s theme, use the Themes panel. To change the menu’s background, audio, text formatting, or transition, use the Settings panel.

Here’s the best part: you can customize multiple menus at once. Just Shift-click on each menu you want to change, and then use the Themes or Settings panel to make your changes.

Note: When you use map view to specify a transition for a menu, every button on that menu will use the same transition. If you want a different transition for some of the menu’s buttons, assign a transition to each button individually as described on page 302.

Checking Transitions

Want to quickly see which, if any, transition a particular menu uses? Simply point to the menu’s icon, and a description of the transition appears.

Adding Content to a Menu

To add content to an existing menu, drag it from the Media panel or the Finder to the menu’s icon.

If you drag a movie or iPhoto album to an existing menu, iDVD creates a button for that item.

You can also change a menu’s background image using the map: just drag a single image to the menu’s icon. (For more details on customizing menu backgrounds, see page 310.)

Looping a Movie or Slide Show

To have a movie or slide show loop (play over and over), select its icon and choose Loop from the Advanced menu.

(When you aren’t in map view, you can specify looping by selecting a movie’s or slide show’s menu button and choosing Loop.)

Adding AutoPlay Content

On many DVDs, a movie appears when the DVD begins playing—an FBI warning, for example, or a movie-studio logo.

You can use map view to add this AutoPlay content to your DVD. Simply drag a movie, a photo, a set of photos, or an entire iPhoto album to the project icon.

If you drag photos to the project icon, you can double-click the project icon to open the slide show editor where you can specify transitions and add background music (page 278).

Don’t want an AutoPlay item after all? Just drag it out of the project icon, and it disappears in a puff of pixel smoke.

Creating a Kiosk DVD

Want a movie or slide show to play automatically and continuously? Drag it to the project icon and then, with the project icon still selected, choose Loop from the Advanced menu.

And as it burns, iDVD 5 provides detailed feedback, letting you know which menu it’s encoding and even showing video frames as it compresses them.

For the first time, iDVD lets you save a completed DVD as a disc image. Need to burn another copy? Use the Finder or a disc-burning utility. This also means that you can burn DVDs using a third-party DVD burner, in addition to an Apple SuperDrive. For many Mac users, that capability alone will make iDVD 5 red hot.
Expanding Your Loop Library

For a GarageBand musician, loops are like groupies: you can’t have too many. A large loop library is a source of creative inspiration. A few minutes of clicking in the loop browser is often all it takes to get the songwriting juices flowing.

A large loop library is also a great source of variety—something that’s missing from many loop-based compositions.

There’s no shortage of loop collections for GarageBand. Apple offers several great collections of its own: the GarageBand Jam Pack series includes not only thousands of loops, but some ear-stunning software instruments and effects, too (see the opposite page).

Many other companies have also created loop packages for GarageBand; you can sample some of them on the DVD that accompanied this book.

With GarageBand 2, your loop options expand even more. GarageBand 2 can work directly with loops in the ACID format. (ACID is a pioneering loop-based music program that debuted on Windows computers back in 1998.) There are more ACID loops available than you can fit on your hard drive—and now they’re compatible with GarageBand.

GarageBand 2 also lets you create your own loops. Record a riff or edit an existing loop, then turn it into a new loop with a few mouse clicks. Your own loops show up in the loop browser and will work like any other Apple Loop: you can shift their pitch and tempo, search for them using the loop browser’s buttons and search box, and more.

Creating Your Own Apple Loops

You can turn any region into a loop with a few mouse clicks.

**Step 1.** If necessary, resize or split a region to make it the proper length of your custom loop.

**Step 2.** Drag the region to the loop browser or select it and choose Add to Loop Library from the Edit menu.

**Step 3.** Specify information about the loop, then click Create.

For rhythmic regions, choose Loop; this enables GarageBand to shift the loop’s tempo to match the song in which it’s used. If the region won’t require tempo shifting—maybe it’s a recording of a single dog bark—choose One-shot.

Assign as much information to the new loop as you like. The more information you specify, the easier it will be to locate the loop in future searches.

Make a note of it. GarageBand made a lot of noise when it came out a year ago. GarageBand 2 turns up the volume with new recording and editing features, new instruments and audio effects, and more. And as the excerpt above describes, it has a new accompanist: the remarkable Jam Pack 4.

GarageBand 1 was limited to recording one track at a time. GarageBand 2 can record up to eight simultaneous audio tracks and one software-instrument (MIDI) track. Each track header now contains a record button: click it for each track you want to record. (To record more than two audio tracks simultaneously, you’ll need an audio interface with more than two outputs.)

GarageBand not only protects that track against accidental editing, it also renders the track’s audio to disk. You can use this feature to free up your Mac’s processor and create more complex songs. It’s similar to the freeze function provided by high-end music software, such as Apple’s Logic Express and Logic Pro.
Narrowing Down Your Choices

If you’ve installed multiple Jam Packs and other loop collections, there may be times when you want to browse for loops from one specific collection.

To focus on a specific loop collection in the loop browser, point to the word Loops ( ), hold down the mouse button, and then choose a collection.

Jam Packs: More than Just Loops

If you’re looking to expand your sonic options, Apple’s series of GarageBand Jam Packs should be one of your first stops. Each Jam Pack provides not only thousands of meticulously recorded loops, but also a large assortment of additional software instruments and effects.

Here’s an overview of each Jam Pack; you can see and hear each one in action on the DVD.

Jam Pack 1. This jack of all trades contains over 2000 loops in a large variety of styles. Its over 100 software instruments include vibes, bass, concert grand piano, twelve-string guitar, and more. Topping things off is a collection of additional guitar simulations and effects.

Jam Pack 2: Remix Tools. If the turntable on the box doesn’t give it away, the sounds will: this Jam Pack is aimed at dance, hip-hop, and electronica composers. Its loops lean toward drum beats and bass lines, synthesizer patterns, and special effects (including, of course, vinyl scratches). Several vintage drum machine software instruments and a buzzing assortment of synthesizers round out the collection.

Jam Pack 3: Rhythm Section. Let the beating begin: this two-DVD set contains roughly 1000 drum loops in a variety of styles, as well as another 1000 bass lines and guitar and keyboard loops. Software instruments include drum sets ranging from jazzy brushes to steel drums, as well as basses and guitars of all kinds—from acoustic to electric, and from Dobro to banjo.

Jam Pack 4: Symphony Orchestra. iPhoto and iMovie HD have the Ken Burns effect; Jam Pack 4 gives you the John Williams effect. It’s a jaw-dropping collection of symphonic orchestra loops and software instruments—the most ambitious Jam Pack of them all. (And the most demanding: to take full advantage of its software instruments, you’ll need at least 512MB of memory, preferably 1GB or more.)

Its beautifully recorded symphonic loops are an aural feast, but what really sets Jam Pack 4 apart are its software instruments. By moving the modulation and pitch-bend wheels of your music keyboard, you can vary the way an instrument plays to obtain amazing realism (see page 322). To create crescendos and decrescendos of a sustained note or chord, move the pitch bend wheel. To obtain different articulations, such as staccato or legato, adjust the modulation wheel. And don’t miss Jam Pack 4’s accompanying PDF documentation, which includes interesting backgronders on orchestral history and arranging.

GarageBand 2’s editing features are also enhanced. You can edit software instrument tracks in standard music notation: click and drag notes to move them, or ⌘-click to create new notes.

GarageBand 2 provides several new features to make you sound better. The new version can refine the timing and tuning of your audio recordings. And the amazing new Vocal Transformer effect can make a male voice sound female, a female voice sound male, and more.

As for other creative enhancements, you can now create pan curves to pan a track’s audio from one channel to another. You can import standard MIDI files by dragging them from the Finder into the GarageBand window. And if you transpose a song to a different key, audio regions that you recorded will transpose accordingly.

Get the rest of the story.

There’s much more to GarageBand 2—and, for that matter, to iLife ’05. It’s been my pleasure to give you a sneak preview of this must-have upgrade. But this booklet is only a small part of the iLife ’05 story. To get the rest of the story, just turn the page.
Want more? Tune into iLifeTV.

At Peachpit Press and Avondale Media, we’re excited about iLife ’05. To celebrate, we’re posting short QuickTime movies that highlight the exciting new features in iLife ’05—a new movie every Friday for five weeks, produced by Avondale Media and hosted by Jim Heid, bestselling author and host of The Macintosh iLife ’05 and its companion Web site, macilife.com.

January 21 iPhoto 5’s new book options
January 28 iPhoto 5’s new editing tools
February 4 iMovie HD in action
February 11 iDVD: themes to burn
February 18 GarageBand 2’s greatest hits

To get started, visit www.peachpit.com/ilifeTV

Improve your iLife.

Master the digital lifestyle with expert Jim Heid.

The Macintosh iLife ’05: An Interactive Guide to iTunes, iPhoto, iMovie HD, iDVD, and GarageBand

Music, movies, and photos come together before your eyes.

In The Macintosh iLife ’05, a lavishly illustrated handbook and a two-hour instructional DVD combine to create the ultimate digital media learning experience. Jim Heid, a contributing editor of Macworld magazine and a veteran voice of the Mac world, has been using and teaching iTunes, iMovie, iPhoto, iDVD, and GarageBand since each program’s debut. In The Macintosh iLife ’05, Heid combines his friendly writing style with engaging video presentations to bring you insights and tips that you won’t find anywhere else. If you enjoyed this preview of iLife ’05, you’ll love his complete, interactive guide—a completely revised and expanded edition of the original Mac digital hub book.

ISBN 0-321-33537-6 Published by Peachpit Press in association with Avondale Media

Save 30% off the $34.99 cover price

Order The Macintosh iLife ’05 book/DVD now and save 30 percent and get free shipping!* Visit www.peachpit.com/ilife and enter EE-TRS1-PGEN when asked to check out. It’s that easy!

*Domestic U.S. only

Want more? Tune into iLifeTV.